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----------------------------------------------------------
1. SYSTEM REQUIREMENTS FOR MICROSOFT ENCARTA ENCYCLOPEDIA
----------------------------------------------------------
What you need to use Encarta 98 Encyclopedia

To install and use Microsoft® Encarta® 98 Encyclopedia you need:
• A Power Macintosh® or a Macintosh with a 25Mhz, 68030 or faster processor (includes 
Macintosh IIci, LCIII, Performa 450 and later models)
• System 7.1 or later
• 16 MB of RAM running system 7.5 or later. 8 MB of RAM running System 7.1
• 43 MB of available hard disk space
• 8 MB of available hard disk space for Microsoft® Encarta® Research Organizer
• Research Organizer requires an additional 3MB of RAM while the encyclopedia is running
• A double-speed or faster CD-ROM drive
• A monitor supporting 256-colors at a 640x480 or higher resolution



To use Encarta Yearbook, Web Links, and monthly online updates, you need:
• A modem (9600 bps or faster)
• Access to the Internet
• 4 MB of additional hard-disk space, plus 1 MB for each monthly update

---------------
2. MEMORY USE
---------------
Memory management and settings to enhance Encarta 98 Encyclopedia's performance

Encarta Encyclopedia needs at least 5 MB of RAM to operate; however, the multimedia 
components run better if more memory is available. On systems with the minimum 
recommended 8 MB of RAM, certain encyclopedia features are not be available. For optimum 
performace, use Encarta Encyclopedia on a system with at least 16 MB of RAM.

If your computer has 8 MB of RAM, and if the system software uses more than 3 MB of RAM, 
you may need to adjust the way memory is used so that Encarta Encyclopedia runs properly. 
If you use System 7.5 or higher, your system software may take up more than 7 MB of RAM. 
For System 7.5 or higher systems, 16 MB of RAM is recommended.

The following are general suggestions for enhancing memory use:

• Run only one application at a time. If other applications are running, close them,  then 
restart Encarta Encyclopedia.

• Reduce the amount of memory used by your system software. To do this, from the Apple 
menu, choose Finder, and then select About This Macintosh (or About This Computer if 
you're using System 7.5.5 or higher). The Largest Unused Block should be greater than 
5000K to run Encarta Encyclopedia. If the only item listed is System Software and the 
Largest Unused Block is less than 5000K, reduce the amount of memory used by your 
system software. For details on adjusting memory, see your Macintosh documentation or 
follow the general suggestions below.

• Open the Memory Control Panel and set the Disk Cache setting to the lowest amount 
possible. 

• You can make more memory available by removing fonts and sounds you aren't using. 
However, do not remove the Arial, Symbol, Times New Roman, MS Reference, and HM 
Phonetic fonts because these are required by Encarta Encyclopedia.

• Third-party system extensions such as screen savers, fax software, desktop 
pictures, utilities that modify menus, and other system enhancements increase the amount 
of memory consumed by your system software. Removing some or all of these extensions 
increases the amount of memory available to applications and minimizes the risk of conflict. 
Save anything you remove from your System Folder and place it in a separate folder on your 
computer's hard disk so that you can replace it later. You can use Apple's Extension Manager 
or an equivalent third-party utility to do this. Do not remove the CD-ROM driver software, or 
QuickTime™ components because these extensions are necessary to run Encarta 
Encyclopedia.



• Turning on Virtual Memory increases the amount of memory available by using space on 
your computer's hard drive to simulate RAM. Although using virtual memory may slow down 
performance, the extra available memory may cause applications like Encarta Encyclopedia 
to be allocated more memory at start up or allow more applications to be run 
simultaneously. When Virtual Memory is turned off, Encarta Encyclopedia's memory 
requirements may increase by 7MB. To turn on Virtual Memory, from the Apple menu, 
choose Control Panels, and then choose Memory. In the  Memory Control Panel, click the On 
button under Virtual Memory.  Then restart your computer. 

Warning: Allocating less than 7,000K for Encarta Encyclopedia's memory requirements may 
cause the program to perform poorly. For example, you may not be able to play video clips 
or enlarge images if the encyclopedia runs out of memory. 

For additional Mac OS memory management support, contact Apple Computer, Inc.

Low memory symptoms and solutions
Following are examples of some low memory symptoms and possible solutions to these 
problems.

Symptom: Incorrect or oddly-sized characters displayed in article text.

Reason: Encarta Encyclopedia uses a variety of fonts to display special characters in article 
text. If there is not enough memory to load one of these fonts, your computer substitutes a 
“best fit” font from one that already is in memory. Encarta Encyclopedia requires the 
following fonts: Arial, Times New Roman, Symbol, MS Reference, and HM Phonetic.

Solution: First ensure that the correct fonts are in your System Folder. If any required fonts 
are missing, reinstall Encarta Encyclopedia Encyclopedia from Disc 1. If all the required fonts 
are properly installed, there may not be enough free system memory to display the custom 
fonts. Try the adjustments described previously to increase system memory.

Symptom: When enlarging an image, I get an empty box or an error message saying the 
encyclopedia is “Unable to Load Image.”

Reason: A single image needs up to 300K of memory to display in 256-color mode and 900K 
in Millions of Colors. If the enlarged image also has sound, more memory is required.

Solution: Close any windows, list boxes, or minimized features you may have open (More 
Info, Outline, Pinpointer, MindMaze, Collages, etc.), and then try again. If this doesn't work, 
you can quit and restart Encarta  Encyclopedia, or try the adjustments described previously 
to increase system memory.

Symptom: When printing from the encyclopedia, the pages are blank or partial pages are 
printed.

Reason: Printing requires creating a duplicate layout for the printer because the printer has 
different margins from the screen. Some of the articles in Encarta Encyclopedia are 
thousands of words long and having two copies of a long article or large image in memory at 



the same time can use up  your computer's available memory.

Solution: Close any windows, list boxes, or minimized features you may have open (More 
Info, Outline, Pinpointer, MindMaze, Collages, etc.), and then try again. If this doesn't work, 
you can quit and restart Encarta Encyclopedia, or try the adjustments described previously 
to increase system memory.  Or you can copy the topic to the Clipboard, quit Encarta, then 
paste it into your word processing program to print it.

----------------
3. PERFORMANCE
----------------
Ways to improve Encarta Encyclopedia's performance

If Encarta Encyclopedia seems to run slowly or if audio and video clips are choppy or 
interrupted, try the following tips to improve performance. 

• If less than 6 MB of memory are free when you start the encyclopedia, you may notice 
some performance problems. See  the previous section, MEMORY USE.

• Increase the preferred size for Encarta Encyclopedia's memory allocation. The 
encyclopedia is set to a suggested memory size of 7000K. If there is sufficient additional 
memory available to run Encarta, you can increase the amount of memory the program 
requests by selecting the Microsoft Encarta Encyclopedia application icon on your hard drive, 
choosing Get Info from the File menu, and changing the preferred size in the area titled 
"Memory Requirements."

Note: If Encarta Encyclopedia is running or busy, you may not be able to change the memory 
allocation. In this case, quit Encarta, and then try again, or restart your computer and try 
again.

• Encarta Encyclopedia may run slowly if you use Virtual Memory to expand available 
memory. For best performance on a 68k Macintosh, turn off Virtual Memory or reduce its 
allocated size in the Memory control panel.  On a Power Macintosh, running with without 
Virtual Memory, Encarta Encyclopedia will require twice as much memory.  Virtual Memory is 
recommended on a Power Macintosh.

• If you are using FWB CD-ROM Toolkit on your computer, you may have difficulty swapping 
discs and playing media. 

• Encarta Encyclopedia is designed to for use with a CD-ROM drive that has a 150K/sec or 
faster transfer rate. A double-speed CD-ROM drive or one with a faster transfer rate will 
provide even better performance in some areas. If your CD-ROM drive has a sustained 
transfer rate less than 150K/sec, it may not be able to supply audio and video information 
to the Macintosh at the speed required. The only solution is to upgrade to a faster CD-ROM 
drive. If you suspect there is a problem with your drive, ensure that the drive is terminated 
properly and that the software is installed properly. For details on SCSI termination, see your 
Macintosh or CD-ROM drive documentation, or contact your Apple dealer.

• Dirty or scratched compact discs can cause your CD-ROM drive to perform poorly. Other 
symptoms include "Cannot Read" error messages and continual spinning of the CD-ROM 



(which appears to cause the computer to freeze). Make sure the bottom surface of the 
Encarta Encyclopedia discs are clean and undamaged.

-----------------------------------------
4. SCREEN SIZES AND COLOR CONFIGURATION 
-----------------------------------------
How to make Encarta 98 Encyclopedia look its best:

• Encarta Encyclopedia checks to ensure that your computer's monitor is set for at least 
256 colors. If your monitor is set to a lower configuration, and if the settings can be 
adjusted to 256 colors, the encyclopedia prompts you to change the settings.

• Encarta Encyclopedia will run on any 256-color, 640x480 (13-inch) or higher resolution 
Macintosh compatible monitor, although Encarta's video clips and still images look best in 
16-bit color (thousands of colors) or 24-bit color (millions of colors).

Note: If your computer is set to use 24-bit color (millions of colors), encyclopedia 
performance is slower and Encarta Encyclopedia uses memory more quickly. If your 
Macintosh is set to this  color mode and you get out-of-memory messages, you can increase 
the amount of memory Encarta Encyclopedia requests. Just click the Microsoft Encarta 98 
icon, choose Get Info from the File menu, and then change the preferred size under "Memory 
Requirements."

• Encarta Encyclopedia is not designed to run in black and white, 16 colors, or on monitors 
that display less than 640x480 pixels, e.g., Color Classics, most PowerBooks and all 12-inch 
Apple monitors.

-------------------
5. SOUND PROBLEMS
-------------------
Audio problems and solutions

If sounds do not play or are interrupted, check the following:

• Sounds will be inaudible if the sound level is turned down to far. To set the sound level, 
open the Sound control panel and adjust the speaker volume to a comfortable sound level. If 
you set the sound level to maximum, you may get sound distortion. If you have external 
speakers, ensure that they are connected properly and turned on. You can usually adjust 
sound level with the external speaker volume knob as well as with the Sound Control Panel.

• If Virtual Memory is turned on, sounds may be choppy. When Virtual Memory is turned on, 
sounds are sometimes temporarily stored on the hard disk rather than in physical RAM. For 
the best performance,  turn off Virtual Memory. To turn off, from the Apple menu, choose 
Control Panels, and then choose Memory. In the Memory Control Panel, click the Off button 
under Virtual Memory.  Then restart your computer. 

Note: You must have enough RAM to run your system software, Encarta Encyclopedia, and 
any other applications you want with Virtual Memory turned off. Also note that it may not 
be appropriate to turn off Virtual Memory on a Power Macintosh. Please see your Apple 



documentation for more information about Power Macintoshes and Virtual Memory.

• In low memory situations, sounds may not load or play. If you cannot get a sound to play 
and you are sure that the Sound Control Panel is set correctly, or if you are receiving error 
messages, you may need to allocate more memory to Encarta Encyclopedia. See the 
MEMORY USE section for suggestions improving memory management.

• Some encyclopedia sounds are stored on the disc in a compressed format. To play these 
sounds, the sound must be read from the disc, and then decompressed. Older or slower 
Macintoshes (such as the Macintosh IIci and Macintosh LC III) may experience interruptions in 
audio playback.

• Version 1.5.1 of Connectix RAM Doubler™ has a known bug that prevents audio and video 
clips from playing properly on Power Macintosh models. To obtain upgrade information, 
contact Connectix Corporation. For RAM Doubler™ support see http://www.connectix.com.

• There are some incompatibilites with Now Menus and Encarta Encyclopedia audio. Avoid 
adjusting the volume of the audio via the Now Menus customized menus while Encarta 
Encyclopedia is running. For Now Menus support see http://www.nowsoft.com.

------------------------
6. PRINTING AND COPYING
------------------------
How to print and copy information from Encarta 98 Encyclopedia:

You can print or copy from any article within Encarta Encyclopedia by selecting a range of 
text and choosing the appropriate command from the Edit menu.  To paste images and text 
together into your word processor - use the Paset Special command found in most word 
processor's Edit menus.

• If you are planning to paste the text into your word processor, you may switch to it via 
the tools submenu under Features from the Main Article screen.  If you have choosen a word 
processor in the Encarta Encyclopedia preferences, it will be opened for you.  If you have not 
picked a word processor, SimpleText will open.  If you have choosen a word processor in 
your preferences and it doesn't open or SimpleText opens, then there is something 
preventing your word processor from launching. See Section 2 on memory use to make sure 
there is enough free RAM for your word processor.  If your computer has sufficient RAM 
available check to see that your word processor launches when you double click the icon.

If you find that printed text is improperly formatted or that special characters do not print 
correctly, try the following:

• Turn off background printing. Encarta Encyclopedia stores custom TrueType fonts within 
the application. This allows Encarta Encyclopedia access to these custom fonts without 
taking up space on your computer's hard drive. However, because many printer drivers start 
a separate application to print jobs in the background, printing errors may result when 
background printing is turned on. To turn off background printing, from the Apple menu, 
choose Chooser, click the active printer, and then click the Off button under background 
printing.



Note: If you install the Encarta Encyclopedia fonts, background printing is fully supported. To 
install these fonts, start the Installer on the Encarta Encyclopedia disc 1, choose Customize 
from the popup menu, select Encarta TrueType Fonts, and then press RETURN.

--------------------
7. TROUBLESHOOTING
--------------------
Known problems and ways to work around them

The following is an overview of problems you may encounter using Encarta Encyclopedia:

• Wrong or Multiple Versions of QuickTime™
During installation, the Installer checks the versions of QuickTime and Sound Manager 
present on your Macintosh, and, if necessary, replaces them with newer versions. However, 
the Installer cannot remove older versions if you or another installer program have renamed 
them. For example, if you renamed an older version of QuickTime to "Old QuickTime", the 
Encarta 98 Installer would install a newer version of QuickTime, but would not find and 
remove the older version. 

The same would happen if another installer application placed a file named "QuickTime 2.0" 
in the Extensions folder. The only QuickTime files found in the Extensions folder should be 
named, QuickTime™, QuickTime™ PowerPlug (Power Mac only), QuickTime™ Musical 
Instruments and QuickTime™ Settings. To fix this problem, manually remove any renamed 
copies of these system components and restart your Macintosh. Encarta Encyclopedia will 
not start unless QuickTime 2.5 is installed and enabled.

• If you are having difficulty launching Encarta, it may be because 32-bit addressing is 
turned off. To turn on 32-bit addressing, from the Apple menu, choose Control Panels, and 
then choose Memory. In the Memory Control Panel, click the On button for 32-bit 
addressing.  Then restart your computer.

• Problems Running Encarta on System 7.0
Due to an incompatibility among Microsoft Encarta, Apple Guide 2.0, and versions of System 
7.0, access to the Encarta Guide from within the Encarta Encyclopedia application has been 
disabled with this configuration. To fix this problem, upgrade to System 7.1 or later. 

• When you copy images or articles from Encarta, they sometimes contain both text and 
pictures. Microsoft® Word and Adobe® PageMaker don’t allow you to use the Paste 
command if the Clipboard contains both text and images. Instead, use the Paste Special 
command, then choose whether you wish to paste the text or picture.

• Difficulty installing Encarta Encyclopedia or changing Encarta's memory partition --
To minimize the number of extensions that Microsoft Encarta Encyclopedia must install in 
your computer's System Folder, the encyclopedia has several built-in PowerPC shared 
libraries. These libraries can stay open even after you quit the application. As a result, you 
should restart your Macintosh if you want to delete the Microsoft Encarta Encyclopedia 
application or edit the application's memory partition sizes in Get Info.

• Do not use the control strip to change monitor resolution settings while Encarta is running 
because there are conflicts between the control strip and Shockwave.



• Speak Article isn't reading the articles or has a choppy voice.
All the Apple PlainTalk components must be installed for Speak Article to work properly.  If 
Speak Article is silent - reinstall Encarta 98 Encyclopedia from CD 1.
If you have a Macintosh with a 68030 processor (such as an LCIII) there are other voices 
that may sound better.  Try Ben, Boris, Brenda, Mariel, Marvin, Mr. Hughes, Otis, Robovox, 
Votron, or Xeno.

• Internet Connections
Depending on your Internet connection, it may take up to several minutes for your browser 
to successfully connect with a site that you have launched from the Internet Directory. Wait 
to see if the connection is successful before you  initiate another link. Attempting to 
connect with multiple Internet sites simultaneously is not recommended. 

Getting the latest troubleshooting information
Additional updated troubleshooting information is available for Encarta Encyclopedia on the 
World Wide Web. You can use the Encarta Encyclopedia Help page, which contains the latest 
information about using and troubleshooting your encyclopedia. Use your Web browser to 
connect to this address:

    http://encarta.msn.com/teleport/fromCD98/troubleshoot.asp

--------------------------------------------------------------
8. SPECIAL INFORMATION ABOUT ENCARTA 98 ENCYCLOPEDIA AND THE INTERNET
--------------------------------------------------------------

How Encarta Encyclopedia uses Internet Config to access the Internet

To use the World Wide Web Links in Encarta Encyclopedia, you need access to the Internet 
through an Internet Service Provider (ISP).

You may already have an ISP through your employer or academic institution. However, if you 
want to use the Internet for personal use, you may need to find an ISP that sells Internet 
access to the general public. If you use an ISP with proprietary software, be sure to ask if 
they have a Macintosh version - some are Windows only - and find out if the Macintosh 
version has similar features to the Windows version. 

Most Macintosh users access the Internet with their modem through a SLIP or PPP account 
using a freeware control panel. There also are commercial versions, and Apple has recently 
released its own PPP control panel designed for use with Open Transport 1.1.2 or later. You 
will use SLIP or PPP based upon the software you use and which protocol your ISP supports. 
PPP is the more flexible protocol and has lately become more prevalent. These accounts 
enable you to run graphic Internet applications that work and feel like Macintosh applications 
should. If your computer has enough memory, you can run several Internet programs 
concurrently with Encarta Encyclopedia. 

Setting up a SLIP/PPP control panel and configuring the MacTCP or the TCP/IP control panel 
(included with Open Transport in System 7.5.2 and later) can be a bit overwhelming. Your 
ISP should walk you through this process, providing critical information including DNS 
addresses and search domains, as well as the essential phone numbers and modem settings 



to get you up and running. 

When Encarta Encyclopedia launches an Internet application, the browser assumes that you 
have a TCP/IP connection already established. Some SLIP/PPP control panels automatically 
dial up and initiate a session when you launch an Internet application, but often the time lag 
required for dialing and negotiating the connection exceeds the timeout on the request. So 
it's a good idea to connect to your ISP before you use the Encarta Encyclopedia Internet 
Directory or other encyclopedia features that connect you to the Internet. 

Depending on the speed of your Internet connection, it may take several minutes for your 
Web browser to connect to a site that you've launched from Encarta Encyclopedia. You 
should wait to see if the connection is successful before attempting to initiate another link. 
Attempting to connect with multiple Internet sites simultaneously is not recommended. 

Encarta Encyclopedia uses software called Internet Config to determine which Web browser 
should be used to connect to the Web. If you aren't currently using Internet Config, it will be 
installed for you when you run the Encarta 98 Installer. Also your Internet Preferences will be 
preset to use Internet Explorer to handle the following Internet resource types: Web (http), 
FTP (ftp), Gopher (gopher), Email (mailto) and Usenet News Groups (news). If you want to 
use a different browser or override any of these defaults, you can start the Internet Config 
application and change the Helper application for that resource type.  Internet Explorer 3.01 
is available for you to install from your Encarta Research Organizer disk.

Note: For more information on Internet Config, please see the user documentation provided 
in the Internet Config 1.3 folder. 

Tips on downloading Encarta updates
To keep your encyclopedia current, you should connect to the Encarta Web site every 
month to download new installments of Yearbook updates, Web Links and the Month in 
Review. Each monthly update file is free. You can download the updates to your hard disk 
and integrate them into the Encarta Encyclopedia. The Encarta Installer copies a sample 
update installment — July 1997 — that you can display right away and use to become 
familiar with these update features.

In-depth instructions for downloading updates are provided within the Downloads screen. 
However, here are some tips on streamlining the downloading process on your Macintosh:

• When you click to download an update file in your Web browser, Internet Config can 
identify Encarta update files based on the file extension and set the file’s type and creator. 
Next it automatically launches Encarta 98 Encyclopedia to integrate the update. The file 
mapping entry for this feature is included in the preconfigured Internet Preferences and 
Internet Explorer preferences installed on your computer's hard drive. If you’re already using 
Internet Config, Encarta 98 Encyclopedia automatically adds this file mapping entry to your 
existing Internet Preferences file the first time you launch Encarta. If you use an Internet 
Config application like Internet Explorer or Anarchie, downloading updates is as simple as 
clicking the filename, waiting for the file to download, and following the directions displayed 
on your screen.

NOTE: If you use a Web browser that isn’t fully Internet Config enabled, you need to save 
the file in the Updates folder (in the Encarta 98 Encyclopedia folder on your hard drive), and 
then integrate the update using the Integrate button on the Downloads screen. If you want 



to connect by typing a URL into your browser, you will need to connect to: 

http://encarta.msn.com/teleport/fromCD98/download.asp

• Encarta updates should be downloaded with binary encoding, not plain text. Most Web 
browsers and FTP clients default to this mode.

• The same update files are used for both the Windows and Macintosh versions of Encarta 
98 Encyclopedia Deluxe Edition. Since the update file is internally compressed and has no 
resource fork, you don't need to use StuffIt Expander to decompress or decode the archives 
posted online. 

• Make sure you have enough free disk space to download and integrate the update file. In 
the process of integrating the update, Encarta will decompress and copy the information 
within the update file to several internal databases, then delete the original file when the 
integration is complete. Consequently, you need enough free space on your computer's hard 
disk for at least two complete copies of the update file.

• Be sure to only download update files for the North American version of Encarta 98 
Encyclopedia Deluxe Edition. Update files for Encarta 96 or 97 Encyclopedia, Standard or 
International releases can not be integrated with content on your encyclopedia CD-ROMs.

• If your computer doesn't have enough memory to run both Encarta 98 and a web browser 
at the same time, you can still update your encyclopedia.
To do so, please follow these instructions:
1.  Connect to http://encarta.msn.com/teleport/fromCD98/downloads.asp
2.  Find the month you are interested and double click to start download.
3.  If you are using Internet Explorer3.01 and it attempts to automatically launch Encarta, 
you will need to "disassociate" the file type since Internet Explorer and Encarta are designed 
to work together. To do this, simply go to your browser preferences list, and select the File 
Helpers control panel.  Then delete the "Yearbook Update" description from the list.  You 
should now be able to download without automatically launching Encarta.

How to choose a Browser with Internet Config:
If Internet Config is not set up properly, you may see the following error message:

Internet Config is not properly installed. Please launch Internet
  Config and ensure that you have a valid helper application selected
  for this Internet resource type.

Or you may click an Internet Link in Encarta Encyclopedia and have nothing happen. 

If this happens, use Internet Config to select your HTTP Helper application. To select the 
helper application, use the following procedure. 

1. Find and open the Internet Config 1.3 folder on your computer's hard drive. 

2. Double-click the Internet Config application icon. 



3. In the Window menu, choose the Helpers item. 

4. Select the HTTP icon, and then click Change. 

5. Click Choose Helper. 

6. Navigate to the location of Web browser. 

7. Select the application, and then click Open. 

8. Click OK. 

9. On the File menu, click Quit and click OK to Save changes. 


